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CHAPTER 8

Teams Reporting 
and Monitoring
In today’s digitally connected enterprise environment, reporting and monitoring are 

crucial elements in ensuring optimal system performance, enhancing user experience, 

and driving strategic decision-making. In the world of Microsoft Teams, these elements 

are no different. This chapter aims to introduce and explain various Microsoft Teams 

reporting and monitoring tools, including the Teams usage reports, custom Power BI 

reports, Call Analytics, and the Call Quality Dashboard. Understanding these tools is 

integral for admins and management to ensure smooth operations, gain insightful data, 

and guide strategic planning.

Monitoring and reporting are integral aspects of Microsoft Teams administration. 

These functionalities offer in-depth insights into user activities, performance metrics, 

and call quality, aiding administrators in managing the service more effectively. 

Microsoft Teams provides various tools, such as the Teams admin center, Microsoft 

365 admin center, and PowerShell, to facilitate advanced reporting and real-time 

monitoring.

Here are the key features:

•	 User activity reports: Helps track the usage patterns of individuals 

or teams, revealing the most frequently used channels, apps, and 

features

•	 Performance metrics: Monitors CPU, memory usage, and network 

statistics related to Microsoft Teams usage

•	 Call analytics: Provides detailed statistics for individual calls and 

meetings, useful for troubleshooting poor call or meeting experiences

•	 Real-time monitoring: Live dashboards for tracking ongoing 

meetings and call quality
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•	 Compliance and security monitoring: Tracks login attempts, data 

sharing, and other security-related activities

•	 Power BI Connector for Teams and CQD

In this chapter, we will cover the following topics:

•	 Introduction to reporting and monitoring: We cover the 

importance and role of reporting and monitoring within 

Microsoft Teams.

•	 Teams usage reports: We cover the built-in usage reports available in 

the Microsoft Teams admin center. We cover what data these reports 

provide, how to access them, and how they can be used to monitor 

user engagement and usage patterns.

•	 Custom Power BI reports: We cover how admins can leverage Power 

BI to create custom reports, providing more specific or complex data 

analysis. We also cover how to connect Power BI with Microsoft 365 

usage analytics and how to use it to gain deeper insights.

•	 Teams Call Analytics: We cover the Call Analytics tool within 

Teams, which provides detailed information on individual calls and 

meetings. We also cover what data is provided and how this tool can 

be used for troubleshooting specific issues reported by users.

•	 Call Quality Dashboard (CQD): We cover the Call Quality 

Dashboard, which provides aggregated data on call and meeting 

quality at an organizational level. We explain how to use the 

dashboard to identify and address systemic issues affecting call 

quality.

•	 Call quality troubleshooting using the CQD: We describe the 

process of troubleshooting.

The chapter concludes by reinforcing the importance of effective reporting and 

monitoring in ensuring a positive Microsoft Teams experience and setting the stage for 

the next topic of discussion.

Chapter 8  Teams Reporting and Monitoring



701

�Microsoft Teams Analytics and Reporting
The new analytics and reporting features in the Microsoft Teams admin center offer 

robust insights into user engagement and system performance within your organization. 

These analytics enable you to understand how your team interacts through messages, 

channels, and device usage, thereby helping you tailor business strategies, training 

programs, and communication initiatives.

The following roles are eligible to access these reports:

•	 Global Administrators

•	 Teams or Skype for Business Administrators

•	 Global Readers (access limited to tenant-level aggregate data)

To access a report, go to the Microsoft Teams admin center and select “Analytics & 

reports” and then View Reports; then select the specific report you want to run.

Note T he Microsoft Teams admin center reports are distinct from the Microsoft 
365 reports available in the Microsoft 365 admin center.

The Microsoft Teams admin center offers a variety of reports, constantly updated for 

different organizational needs.

•	 Teams Usage Report: Metrics for active users, channels, messages, 

and privacy settings

•	 Teams User Activity Report: Detailed user-level statistics including 

message counts and meeting participation

•	 Teams Device Usage Report: Breakdown of device types used to 

access Teams

•	 Teams Live Event Usage Report: Metrics around live event views, 

start times, and statuses

•	 Teams PSTN Reports: Multiple reports related to public switched 

telephone network (PSTN) usage
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•	 Teams Information Protection License Report: Data related to 

licenses and change notifications

•	 Teams Virtual Appointments Report: Metrics for virtual 

appointments, including attendee details and wait times

Figure 8-1 shows the list of reports.

Figure 8-1.  Usage report list and options

�Microsoft Teams Usage Activity
The Microsoft Teams Usage Activity section is part of the Microsoft 365 dashboard. It 

gives you a quick look at how people in your company are using Microsoft Teams. You 

can see things such as how many people are active, how many messages are being sent, 

and how many meetings are happening.
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Here’s how to access the report:

	 1.	 Go to the admin center and click Reports.

	 2.	 Then click Usage.

	 3.	 On this page, find the Microsoft Teams card and click “View more.”

You’ll find different graphs and tables showing you various details.

•	 Channel usage: This graph shows how often different channels are 

being used.

•	 Team usage: This one shows how many different teams are active.

The report also has more specific details for each team such as when was the last 

time someone did something in a team, how many people are active, etc.

•	 Customizing the view: You can pick what details you want to see by 

selecting “Choose columns.”

•	 Saving the report: If you want to look at this data later, you 

can download it as an Excel file. This lets you sort and filter the 

information however you want.

•	 Time range: You can look at activity from the last week up to the last 

6 months. But if you pick a specific day to look at, you’ll see only up to 

28 days from today’s date.

Note that the information might take up to 48 hours to show up. So if you’re looking 

for what happened on September 1, you might not see it until September 3. Also, the 

data is checked daily for the last three days to make sure it’s accurate.

The Teams usage chart gives you information on different kinds of teams and 

activities. Here’s what each term means:

•	 Private teams: Teams that are invite-only

•	 Public teams: Teams anyone can join

•	 Active private teams: Invite-only teams that people are 

currently using

•	 Active public teams: Open teams that people are currently using

Chapter 8  Teams Reporting and Monitoring



704

These are the metrics for individual teams:

•	 Team ID: The unique number or name that identifies each team

•	 Internal Active Users: People in your organization who have done 

something in Teams recently, not including guests

•	 Active Guests: People not in your organization who have been active 

in Teams

•	 External Active Users: People from outside your organization who 

are active but are not logged in as guests

•	 Active Channels: Channels in active teams that people are 

currently using

•	 Active Shared Channels: Channels that are active and are shared 

with people outside the team

•	 Total Organized Meetings: All the meetings set up by a user

•	 Posts: Number of new messages

•	 Replies: Number of responses to messages

•	 Mentions: Number of times people are tagged

•	 Reactions: Number of emojis or likes on messages

•	 Urgent Messages: Number of messages marked as urgent

•	 Channel Messages: Unique messages in team chats

•	 Last Activity Date: The most recent date someone in the team did 

something

Note T hese counts include only those activities done directly in Teams, not 
through other services or apps connected to Teams.

If you’re an admin and you want to make this data anonymous, you can do the 

following:

	 1.	 Go to the Microsoft 365 admin center.

	 2.	 Navigate to Settings ➤ Org Settings.
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	 3.	 On the Services tab, click Reports.

	 4.	 Choose “Display anonymous identifiers” and save the changes.

This will hide names, emails, and other personal information in the reports.

�Understanding Microsoft Teams User Activity Reports 
in Simple Terms
The Microsoft 365 dashboard lets you see how people are using Microsoft products, 

including Teams, in your company.

This is how you find the report:

	 1.	 Go to the admin area and click Reports.

	 2.	 Then click Usage.

	 3.	 Next, click “View more” under the Microsoft Teams section.

In this report, you’ll see various tabs. Click “User activity” to see what people are 

doing in Teams. You can choose which details to show in the report. You can also 

download the data to look at it in Excel.

This is what the key terms mean:

•	 Username: This is the email of the person using Teams.

•	 Tenant name: This is company where the user works.

•	 Is external: This shows if the user is from outside your company.

•	 Channel messages: This is how many messages a person sent in 

Teams chats.

•	 Posts: This is first message in a chat.

•	 Replies: These are the responses to those first messages.

•	 Urgent messages: These are messages marked as important.

•	 Total meetings: This is the total number of meetings the user joined.

•	 1:1 calls: These include direct calls between two people.

•	 Last activity date: This is the last time the user did something 

in Teams.
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These are other activities:

•	 Audio duration: Total time spent on audio calls

•	 Video duration: Total time spent on video calls

•	 Screen share duration: Total time spent sharing screens

Note T his report doesn’t include data from other apps that might be connected 
to Teams.

By understanding these terms, you can get a better idea of how people in your 

company are using Microsoft Teams.

�Setting Up the Power BI Connector for Microsoft Teams’ 
Call Quality Dashboard: A Simple Guide
This section shows how to set up the Power BI Connector for tracking call quality on 

Microsoft Teams. Be aware, the data source used in the report needs to be updated every 

two months. For the limitations of this tool, visit the Microsoft website.

Here is how to install the tool:

	 1.	 Create a folder: Check if you have a Custom Connectors folder 

in your Documents folder under Power BI Desktop. If not, 

create one.

	 2.	 Download a file: Get the connector file (a *.pqx file) and put it in 

the folder you just made.

	 3.	 Open Power BI: Launch the Power BI Desktop application.

	 4.	 Change the security settings: Go to File ➤ Options and Settings 

➤ Options ➤ Security. Here, allow any extension to load without 

any warning (though it’s not recommended).

	 5.	 Restart Power BI: Close and re-open the program.

	 6.	 Load the template: Go to File ➤ Open Reports ➤ Browse Reports. 

Change the file type to Power BI Template files (*.pbit), find the 

template you downloaded, and open it.
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	 7.	 Sign in: Use your Azure AD credentials to sign in to the Call 

Quality Dashboard.

	 8.	 Final check: If you see various dimensions and measures in the 

Fields pane, you’re good to go.

If a new version comes out, just replace the old *.pqx file with the new one in the 

Custom Connectors folder.

Here are some common issues and fixes:

•	 Expired data source: The report uses a free database that needs to 

be updated every two months. Set a monthly reminder to do this.

•	 Error messages: If you get errors, make sure you’re using the 

December 2020 version of Power BI or later. If you have the right 

version but still see errors, reinstall the connector file.

•	 Web settings: When you publish the report online, you may need 

to update some credentials. Go to Datasets in Power BI Online, 

find your report, click the three dots for the menu, and update the 

credentials.

By following this simplified guide, you should be able to set up and use the Power BI 

Connector for the Microsoft Teams Call Quality Dashboard effectively.

�Microsoft Teams App Usage Report
The App Usage Report in Microsoft Teams helps you understand which apps people are 

using. You can find out about Microsoft apps like Viva Learning, third-party ones like 

Polly, and custom business apps.

You can use it to find out the following:

•	 The number of apps installed by users

•	 The apps that are actually being used, sorted by type

•	 The usage on different platforms: Windows, Mac, web, or mobile

•	 The number of active users and teams for each app

Note T he report doesn’t include data on custom apps that are side-loaded.
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To see these reports, you need to be an admin. In the Teams admin center, do the 

following:

	 1.	 Go to Analytics & reports ➤ Usage reports.

	 2.	 Choose “Apps usage” under the Report section.

	 3.	 Pick a date range and click “Run report.”

You’ll see the following in the report:

•	 Time range: You can see trends over 7, 30, 90, or 180 days.

•	 Data delay: The report might be one to two days behind.

•	 Graphs: Hover over the dots on the graph to see specific numbers for 

that date.

•	 Filters: You can filter the data to see specific types of apps.

•	 Table info: The table breaks down usage by each app.

•	 App ID: Unique identifier for the app

•	 App name: The app’s name

•	 Publisher: Who made the app

•	 Teams and users: How many are using it

•	 Platforms: Where it’s being used

•	 Last used: The last time someone used it

•	 Customize the table: You can click “Edit columns” to change what’s 

displayed.

•	 Download: You can save the report as a CSV file for more detailed 

analysis.

To manage apps, go to Manage Apps in the Teams admin center. You’ll need the app 

name or external app ID for this.

By understanding how to read and use the Teams App Usage Report, you can get a 

clearer picture of app utilization in your organization.
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�Microsoft Teams Device Usage Report
The Microsoft 365 Reports dashboard lets you see how people in your company are using 

different Microsoft products, including Teams. The Teams Device Usage Report helps 

you know what devices (such as computers and phones) people are using for Teams.

Here’s how to access the report:

	 1.	 Go to the admin center and click Reports ➤ Usage.

	 2.	 On the main page, click “View more” on the Teams activity card.

You can do the following:

	 1.	 Choose the “Device usage” tab to see what devices people 

are using.

	 2.	 You can customize the report by clicking “Choose columns.”

	 3.	 You can also download the data into an Excel file for more 

analysis.

You can look at data from the last week, month, or even half a year. If you pick a 

specific day, you’ll see info for up to 28 days from today.

Here’s what the report tells you:

•	 Username: The person’s name

•	 Windows: Shows if they used Teams on a Windows computer

•	 Mac: Shows if they used Teams on a Mac computer

•	 iOS: Shows if they used Teams on an iPhone or iPad

•	 Android: Shows if they used Teams on an Android phone

•	 Chrome OS: Shows if they used Teams on a Chromebook

•	 Linux: Shows if they used Teams on a Linux computer

•	 Web: Shows if they used Teams on a web browser

•	 Last activity date: Shows the last time the person did something 

in Teams

•	 Is licensed: Shows if the person is allowed to use Teams

This report is a handy tool for understanding what devices are popular for Teams in 

your company.

Chapter 8  Teams Reporting and Monitoring



710

�Microsoft Teams PSTN Blocked Users Report
The PSTN Blocked Users Report in Microsoft Teams helps you find out who in your 

company can’t make phone calls using Teams. You can see details like their phone 

number and why they can’t make calls.

Here’s how to get access to the report:

	 1.	 Go to the Microsoft Teams admin center.

	 2.	 Click “Analytics & reports” and then “Usage reports.”

	 3.	 Find and click “PSTN blocked users.”

	 4.	 Click “Run report.”

Here’s what the report tells you:

•	 When was it made: The report is usually a day or two behind  

real-time activities.

•	 Graph info: The graph shows dates on the x-axis and the number of 

blocked users on the y-axis. Hover over any point to see how many 

users were blocked on a specific date.

•	 Table details: The table lists everyone who can’t make phone calls. 

Here’s what the columns mean:

•	 Display Name: The person’s name. Click it to go to their settings.

•	 Phone: Their assigned phone number.

•	 Blocked Reason: Why they can’t make calls.

•	 Blocked Action: Shows if they are blocked or unblocked from 

making calls.

•	 Blocked Time: When they were blocked.

You can customize this table to see only what you need.

•	 Edit Columns: Click this to add or take away information from 

the table.

•	 Full Screen: Click this if you want to see the report in full- 

screen mode.
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This report is a useful tool for managing phone call permissions in your company.

�Microsoft Teams PSTN Minute Pools Report
The PSTN Minute Pools Report in Microsoft Teams shows you how many calling minutes 

your company has used this month. It tells you what type of call plans are being used, 

how many minutes you have left, and where the calls are being made from.

Here’s how to access the report::

	 1.	 Open the Microsoft Teams admin center.

	 2.	 Click “Analytics & reports” and then “Usage reports.”

	 3.	 Choose “PSTN minute and SMS(preview) pools” and hit ‘Run 

report.”

Here’s what is on the report:

•	 Report date: The data in the report is usually a day or two old.

•	 License activity: Click a call plan (or “license”) to see how it’s 

being used.

•	 Graph info: The x-axis shows countries, and the y-axis shows 

minutes. Hover over the bars to see the minutes used in each 

country.

•	 Filters: You can choose what to see on the graph. Click terms like 

“Unused,” “Domestic users,” “No data,” or “International used” to 

filter the view.

•	 Table details: Here’s what the columns mean:

•	 Country or Region: Where the calls are being made

•	 Capability Description: The type of call plan, like “Domestic and 

international calling plan (1200 domestic minutes)”

•	 Total Minutes: All the minutes you can use this month

•	 Minutes Used: Minutes already used this month
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•	 Minutes Available: Minutes left for this month

•	 Capability: The specific plan or license being used for the 

call, like “MCOPSTN1 - Domestic Calling Plan (3000 min US / 

1200 min EU plans)”

	 You can customize this table.

•	 Edit Columns: Use this to add or remove information in the table.

•	 Full Screen: Click this to make the report bigger on your screen.

This report helps you keep track of your company’s call usage.

�Microsoft Teams PSTN and SMS Usage Report
This report in Microsoft Teams tells you about the calls and audio meetings happening 

in your company. If you use Microsoft for phone services, you’ll see details on the Calling 

Plans tab. If you use your own phone services, you’ll find information under Direct 

Routing.

Note I f you use Telstra or Softbank for your calls, this report won’t show you 
anything. You’ll need to contact them for your call details.

Here’s how to access the report:

	 1.	 Go to the Microsoft Teams admin center.

	 2.	 Click “Analytics & reports” and then “Usage reports.”

	 3.	 Choose “PSTN and SMS (preview) usage.”

	 4.	 Pick a time range for the report, either the last 7 or 28 days, or set 

your own range.

	 5.	 Click “Run report.”

Here’s what the report includes:

•	 Time range: The data shows trends over the last 7, 28, or custom 

range of days.

•	 Report date: Data may be one to two days old.
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•	 Graph: The x-axis shows the time range you chose; the y-axis shows 

the total number of calls. Hover over a point to see the call count for 

that day.

•	 Table: This is the meat of the report. It tells you the following:

	 a.	 Time stamp: When the call started.

	 b.	 User info: Who made or received the call. Click the name to 

see more settings.

	 c.	 Call details: Where the call came from or went to, and what 

it cost.

	 d.	 Call types: What kind of call it was (like a conference call, 

transferred call, etc.).

	 e.	 More: Duration of the call, if it’s local or international, 

and so on.

•	 Customize the table: Click “Edit columns” to pick what information 

you want to see.

•	 Filter: You can sort the report by username or type of call.

•	 Full screen: Make the report bigger to see details more easily.

•	 Export: You can save the report to look at later. Just click Export to 

Excel and then Download.

This report helps you understand how your team uses calls and meetings so you can 

make better decisions.

�Direct Routing PSTN Usage Report
The Direct Routing PSTN Report in Microsoft Teams shows you details about phone calls 

made or received in your organization using your own phone service.

Here’s what you will find on the report:

•	 Time period: You can look at data for the last 7 or 28 days.

•	 Report date: Each report has the date it was made. Data might be 

one to two days old.
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•	 Graph info: The graph shows the total number of calls over your 

chosen time period. Hover over a point to see details for that day.

•	 Detailed table: This table tells you more about each call.

•	 Time stamp: When the call started.

•	 Display name: The name of the person or bot involved. Click it to 

go to their settings.

•	 SIP address: Contact address of the person or bot in the call.

•	 Caller/callee number: Who made and received the call.

•	 Call type: Tells you the type of call (inbound, outbound, 

emergency, etc.). For example:

•	 If a user got an incoming call, it’s labeled “dr_in.”

•	 If a bot made an outgoing call, it’s labeled “dr_out_bot.”

•	 Edit columns: You can choose which details to show in the table.

•	 Full screen: Click to see the report in full-screen mode.

•	 Download: You can download the report for offline use or billing.

Here is some additional information:

•	 Caller/Callee fields: These can show different types of phone 

numbers or even text, depending on your setup. For example, it could 

show Internal Revenue Service instead of a number for spam calls.

That should give you a more straightforward understanding of what the Direct 

Routing PSTN Report is and what information you can get from it.

�Phone Number Obfuscation Based on Location
Privacy regulations require that phone numbers from outside the customer’s 

organization be partially concealed. The last three or four digits are replaced with 

asterisks (e.g., +123 456789***). For calls coming in, the number of the person calling is 

obscured; for calls going out, the recipient’s number is obscured. This applies to PSTN 

and Direct Routing reports in the tenant’s admin center, data exports, and call logs 

accessed via Microsoft Graph. Different rules may apply in Call Analytics and the Call 

Quality Dashboard.
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The rules vary based on the country or region where the organization is located.

Country/Region Digits to Obscure

Belgium 3

Switzerland 4

Germany 3

Denmark 3

... ...

�Shared Correlation ID Details
The Shared Correlation ID appears only in the downloaded Excel report and signifies 

related calls. Here are some examples:

•	 Scenario 1: PSTN User 1 calls Teams User 1; no Shared 

Correlation ID.

•	 Scenario 2: Teams User 1 calls PSTN User 1; no Shared 

Correlation ID.

•	 Scenario 3: PSTN User 1 calls Teams User 2; a Shared Correlation ID 

indicates related calls.

�Data Retention Policies
Data retention varies based on location-specific regulations.

Country PSTN Plans Direct Routing

Canada 150 days 150 days

Switzerland 365 days 365 days

Germany 365 days 100 days

... ... ...
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The rules also apply to data exports and logs in the tenant’s admin center and 

Microsoft Graph. The retention duration defaults to the tenant’s location if a user’s 

location isn’t specified.

�Exporting Call Data
Click Export to Excel and then Download on the Downloads tab. The process may take 

varying amounts of time depending on the data size. The downloaded ZIP file will 

include PSTN.calls.[UTC date].csv and DirectRouting.calls.[UTC date].csv for 

PSTN and Direct Routing data.

Additional fields are not visible online.

A parameters.json file for selected export ranges and capabilities.

The exported data complies with the RFC 4180 standard and can be read by Excel or 

other compliant editors. Specific details on columns, data types, and their meanings are 

also provided in the exported report. The data can be retained for up to one year or five 

months for PSTN and Direct Routing reports, respectively, unless otherwise restricted by 

local laws.

�Audio Conferencing Dial-Out Usage Report
The Audio Conferencing Dial-Out Usage Report in the Microsoft Teams admin center 

helps you understand how much you’re spending on audio calls and how much the 

service is being used. It shows details about money spent and call minutes used. This 

helps you plan how much money you’ll need for future calls.

Here’s how to access the report:

	 1.	 Open the Microsoft Teams admin center.

	 2.	 Click “Analytics & reports” and then “Usage reports.”

	 3.	 Find and click the Audio Conferencing Dial-Out Usage Report.

Here’s how to pick a date and country:

•	 You can choose to see data from the last 7 or 28 days or pick your own 

date range.

•	 You can also filter the report by country.

Chapter 8  Teams Reporting and Monitoring



717

The report has three main sections, each showing different charts and details.

•	 Cost Tab: Shows how much money was spent on calls

•	 Minutes of Use Tab: Shows how many minutes were used in calls

•	 Dial-Out Calls Tab: Shows the total number of calls made

All the information takes about one to two days to show up in the report.

Important Note T he person who set up the meeting is listed as the one who 
used the minutes and spent the money, even if they didn’t make the calls.

Here are the tab details:

•	 Cost tab: A graph shows spending over time, and a section below the 

graph shows the total cost of calls.

•	 Minutes of the Use tab: A graph shows minutes used over time, and 

a section below the graph shows the total minutes.

•	 Dial-Out Calls tab: A graph shows the number of calls over time, and 

a section below the graph shows the total number of calls.

The table at the bottom breaks down usage by each person. It shows the following:

•	 Who organized the meeting

•	 Their username

•	 How many minutes they used

•	 How much they spent

You can search and export date using this report.

•	 You can search for a specific user’s data.

•	 You can click a meeting organizer’s name to see more details.

•	 You can download any of these reports as a CSV file for further study. 

Just click Export to Excel and then download the file when it’s ready.
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�Microsoft Teams Live Event Usage Report
The Teams Live Event Usage Report helps you understand what’s happening with live 

online events in your company. It shows you details like when an event started, how 

many people watched it, and who organized it.

Here’s how to access the report:

	 1.	 Open the Microsoft Teams admin center.

	 2.	 Click “Analytics & reports” and then “Usage reports.”

	 3.	 Choose “Teams live event usage.”

You can use certain filters on this report.

•	 You can look at data from a specific time period, even up to a year.

•	 Optionally, you can also filter the report to show events organized by 

a specific person.

Here’s what’s on the report:

•	 Trends: You can look at event data from the last 7 or 28 days or pick 

your own date range.

•	 Up-to-date info: The report updates almost instantly when you 

refresh the page.

•	 Graph details: The graph shows the number of people who watched 

the events during your chosen date range.

•	 Table info: The table under the graph breaks down each event by the 

following:

•	 Event name

•	 Start time

•	 Status (if the event has happened yet)

•	 Who organized it

•	 Who presented it

•	 How many people watched it
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•	 If it was recorded or not

•	 What tool was used to produce it

If an account no longer exists, it shows as --.

•	 Customize the table: You can add or remove columns to see only the 

details you want.

Important Notes 

•	 The report can show up to 100 events at a time. Use date filters to 
see more.

•	 People who are present without logging in and those who watch a 
recorded event are not counted.

Clicking an event name gives you a detailed summary and allows you to see or 

download files related to that event, such as transcripts and recordings.

If your company uses special tools like Microsoft eCDN, Hive eCDN, or Kollective 

eCDN, you can get even more detailed reports.

�Microsoft Teams Webinar Usage Report
The Webinar Usage Report in Microsoft Teams helps you understand your company’s 

webinars. It shows useful details such as the webinar title, when it started and ended, 

and who was involved in organizing or presenting it.

Here’s how to access the report:

	 1.	 Open the Microsoft Teams admin center.

	 2.	 Click “Analytics & reports” and then “Usage reports.”

	 3.	 Select “Webinar usage reports.”

Here are the date and organizer options:

•	 You can choose a specific time range for the data, even up to a year.

•	 If you want, you can also show only those webinars organized by a 

particular person.
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Here’s what’s on the report:

•	 Trends: You can choose to see data from the last week or the last 

month, or you can pick your own dates.

•	 Up-to-date info: The report updates almost instantly each time you 

refresh the page.

•	 Chart info: The graph shows the total number of views. You can 

hover over any point to see the number of views on a particular date.

•	 Table details: The table below the graph gives you more information 

about each webinar, such as the following:

•	 Unique webinar ID

•	 Webinar title

•	 Start and end times

•	 Names of the organizer, co-organizer, and presenters

•	 Whether the webinar is open to everyone in the organization or 

is private

If an account is deleted or no longer exists, it will show as --.

Important Note T he report will show a maximum of 100 webinars. If you want to 
see more, you’ll need to use date filters to narrow down the list.

�Microsoft Teams Information Protection License Report
This report helps you understand how different apps are using Microsoft’s special APIs 

that need a paid license. It shows data only for apps using these APIs in a specific way 

(model=A). It won’t show anything for other models or trial versions.

Here’s how to see the report:

•	 Access: You need to be a Teams admin to view this report.

•	 Steps: Open the Microsoft Teams admin center, click “Analytics & 

reports,” click “Usage reports,” and click Pick Information Protection 

License.
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You have the following options:

•	 Time frame: Choose the date range you’re interested in.

•	 App selection: You can pick a specific app to focus on.

You’ll see the following:

•	 Categories: The report shows data like how many users have a 

license, who doesn’t, and the API usage limits.

•	 Export and tabs: You can download the data or switch between tabs 

to see different types of API usage.

Here’s what is on the report:

•	 Trends: See app and API usage trends for up to the last three months.

•	 Apps: Lists all the apps using these special APIs.

•	 Licensed users: Shows how many users have a valid license.

•	 Unlicensed users: Shows how many don’t.

•	 API limits: Shows the maximum API calls allowed before extra 

charges apply.

•	 Actual API use: Shows how much of the API limit has been used.

You can also see specific details such as the following:

•	 Who triggered notifications

•	 Who updated messages

•	 How many messages were exported

Here are some additional tips for this report:

•	 Download: You can download the data for offline checking. It 

downloads only the tab you are currently looking at.

•	 Hide/show data: You can choose what data labels to show in 

the charts.

•	 API types: Each tab gives details on a specific type of API such as 

notifications or message exports.
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If you want to hide user-specific information such as names and emails, here are 

the steps:

	 1.	 You need to be a global admin.

	 2.	 Go to the Microsoft 365 admin center, click Settings, click Org 

Settings, and click Reports.

	 3.	 Choose to display anonymous identifiers.

Click “Save changes,” and this will make reports anonymous in both the Microsoft 

365 and Teams admin centers.

�Microsoft Teams SMS Notifications Usage Report
This report helps you understand how your organization is using SMS (text messages) 

to remind people about their virtual appointments. It covers text reminders sent in the 

Virtual Appointments app and in the Teams healthcare records system.

You must be one of the following: Global admin, Teams admin, Global reader, or 

Report reader.

Here’s how to view the report:

	 1.	 Open the Microsoft Teams admin center.

	 2.	 Select “Analytics & reports” and then “Usage reports.”

	 3.	 Choose SMS notifications usage.

	 4.	 Pick 7 days, 30 days, or 90 days for the timeframe.

	 5.	 Run the report.

Here’s what’s on the report:

•	 Chart overview: A chart shows how many texts were sent 

each month.

•	 Table details: The table gives you the nitty-gritty about each text.
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Here are the key parts of this report:

•	 Date: Shows when the report was made. It’s usually updated every 24 

to 48 hours.

•	 Chart axes: The chart’s x-axis shows the months, and the y-axis 

shows the number of texts sent.

•	 Filter options: You can choose to see only texts related to virtual 

appointments or healthcare records.

•	 Table info: You’ll see the exact time a text was sent, where it came 

from, the type of text (reminder or confirmation), and whether it was 

delivered or not.

These are the different delivery statuses:

•	 Delivered: The text reached the phone.

•	 Not Delivered – Blocked by recipient: The person opted out of texts.

•	 Not Delivered – Invalid phone number: It had the wrong 

number format.

•	 Not Delivered - Phone number doesn’t exist: The number isn’t real 

or allocated.

•	 Not Delivered - Blocked phone number: The number is on a 

spam list.

•	 Not Delivered - Unreachable phone number: The phone was off or 

had no signal.

•	 Not Delivered - Spam detected: A filter caught it as spam.

•	 Not Delivered - Recipient blocked: The number is blocked from 

receiving any texts.

•	 Not Delivered - Other error: Miscellaneous errors.

Now you can better track and understand how your organization is using SMS 

notifications for virtual appointments.
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�Custom Power BI Reports
Let’s talk about custom Power BI reports.

�Custom Power BI Reports: Leveraging Power BI for CQD 
Analysis in Microsoft Teams
In July 2022, a new Quality of Experience Report (QER) template was introduced for 

Power BI query templates in the CQD of Microsoft Teams. This template was designed 

to replace the older CQD Power BI templates from 2020. Although the older templates 

will remain accessible for demonstration, they are no longer maintained or updated. It’s 

recommended to transition to the QER template for ongoing support. Note that this does 

not affect the CQD Teams Auto Attendant & Call Queue Historical Report.

For those interested in employing Power BI to analyze CQD data in Microsoft 

Teams, you can download the specialized Power BI templates provided by Microsoft. 

Upon opening these templates, you’ll be prompted to authenticate using your CQD 

admin credentials. These templates are customizable and can be shared across your 

organization, provided users have both a Power BI license and CQD admin access.

Before you can start utilizing these Power BI templates (PBIT files), you’ll need 

to install the Power BI Connector for Microsoft CQD. This is done by utilizing the 

MicrosoftCallQuality.pqx file that comes as part of the download package.

Ensure you have the appropriate CQD role permissions to access these Power BI 

reports.

Let’s talk about the available templates.

QER.pbit is an all-in-one report template that offers a variety of functionalities.

•	 Search by meeting URL, conference ID, and more

•	 Meeting and user health details

•	 Metrics for media setup, reliability, and different types of media 

(audio/video/sharing)

•	 Insights into VPN impact, top problem areas, daily reports, and 

general usage statistics

•	 User feedback and network metrics
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QER MTR.pbit is optimized for Microsoft Teams Rooms and covers MTR overview, 

network, and device health metrics.

QER PS.pbit is designed for Microsoft Teams Phone System deployments and 

includes the following:

•	 Direct Routing and Phone System Reports

•	 SBC and PSTN overviews

CQD Teams Auto Attendant & Call Queue Historical Report.pbit focuses on 

the following:

•	 Call analytics for auto attendants and call queues

•	 Agent activity timelines

For deprecated templates, users can still find information on PSTN Direct Routing, 

help-desk reports, and more, but these are no longer updated.

For further details on each template and how to maximize your reporting experience, 

you can refer to the respective guides provided by Microsoft.

�Installing and Setting Up Microsoft Call Quality Connector 
for Power BI
Before taking advantage of Power BI’s query templates for Microsoft Teams’ CQD, you 

must first install the Microsoft Call Quality Connector for Power BI. This connector 

comes in the form of a MicrosoftCallQuality.pqx file, which is included in the 

download package. Then follow these steps:

	 1.	 Locate or create a Custom Connectors folder: Check if 

you already have a [Documents]\Power BI Desktop\Custom 

Connectors folder on your computer. If it doesn’t exist, create one.

	 2.	 Download and move the connector file: Download the 

connector file, which will have either a .mez or .pqx extension, 

and move it to the Custom Connectors directory.

	 3.	 Security settings: If the connector file has a .mez extension, 

you’ll need to modify your security settings. Follow the guidelines 

provided in the custom connector setup documentation for 

this step.
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	 4.	 Version updates: If a newer version of the Microsoft Call Quality 

connector becomes available, replace the older file in the Custom 

Connectors directory with the new version.

Here’s how to set up the connection:

	 1.	 Initiate a connection: Open Power BI Desktop, navigate to the 

Home tab, and click Get Data.

	 2.	 Choose a data source: In the Get Data window that appears, go 

to Online Services and then select Microsoft Call Quality (Beta). 

Click Connect to proceed.

	 3.	 Authenticate: You’ll be prompted to sign in. Use the same 

credentials that you normally use for the Call Quality Dashboard.

	 4.	 Data connectivity mode: A prompt will appear giving you 

a choice between two data connectivity modes. Choose 

DirectQuery and confirm with OK.

	 5.	 Load a data model: A final window will display the data model for 

the Call Quality Dashboard. At this stage, you’ll see only the data 

model, not the actual data. Click Load to finalize the setup.

	 6.	 Query building: With the data model loaded on the right side of 

your Power BI window (though no data will be visible yet), you 

can now proceed to construct queries to retrieve data.

If you encounter any unclear steps during setup, a more comprehensive guide can be 

found in the “Quickstart: Connect to data in Power BI Desktop” documentation.

Building queries in Power BI for Microsoft Teams data involves a series of steps from 

connecting your data source to visualizing the information. Here’s a step-by-step guide 

on how to go about it:

	 1.	 Connect to a data source: Open Power BI and navigate to the 

Home tab. Click Get Data and select the appropriate data source. 

For Teams data, you might connect to Microsoft’s Graph API, 

SQL databases, or other relevant sources where your Teams data 

is stored.
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	 2.	 Authenticate: Follow the authentication prompts, entering the 

credentials used for your Teams account or another relevant 

service.

	 3.	 Import or use DirectQuery: Choose whether to import the data 

into Power BI or use DirectQuery to query the data directly from 

the source.

	 4.	 Select tables and columns: Once you’re connected, you’ll see a 

navigator panel showing available tables and columns. Select the 

ones relevant to your Teams analysis.

	 5.	 Load data: Click Load to bring the data into Power BI. It will 

appear in the Fields pane on the right side.

	 6.	 Create basic queries: Navigate to the Data view by clicking the 

table icon at the left. Here you can create new columns, filter 

data, or perform basic transformations using the formula bar and 

Power Query Editor.

	 7.	 Make DAX queries: For more advanced queries, you can use 

Data Analysis Expressions (DAX) in the formula bar to create new 

measures, calculated columns, or calculated tables.

	 8.	 Query parameters and variables: If your query needs to be 

dynamic, consider adding parameters or variables.

	 9.	 Choose visualizations: Switch back to Report view by clicking the 

bar chart icon at the left. Drag and drop the fields onto the report 

canvas and choose the type of visualizations (charts, tables, etc.) 

you’d like to use.

	 10.	 Publish and share: Once your query and visualizations are set up, 

click Publish to share the report with others in your organization 

who have a Power BI license.

For more complex scenarios such as timeseries analysis, user behavior funnels, or 

anomaly detection, you might want to use advanced DAX functions or even R/Python 

scripts, which can be run within Power BI.

By following these steps, you can build a range of queries to analyze your Microsoft 

Teams data, all tailored to your specific needs.
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�Creating a Focused Report Using Drill-Through in Power 
BI for Microsoft Teams
Drill-through functionality in Power BI offers a streamlined way to dive deeper into your 

Microsoft Teams Call Quality data. Once you’ve set up your basic query via the Microsoft 

Call Quality connector, implementing drill-through is fairly straightforward.

	 1.	 Add a new page for focused reporting: Create a new report page 

where you’ll house your drill-through queries.

	 2.	 Define the drill-through dimension: On this new page, select the 

data dimension you plan to use for drill-through. Then drag it to 

the Drill-through area in the Visualizations pane.

	 3.	 That’s It! Now, any other query on different report pages that uses 

the same dimension to drill down to this more focused report, 

applying the selected dimension’s value as a filter automatically.

When using the Microsoft Call Quality connector, it’s advisable to design your 

queries to be drill-through-friendly. Instead of loading a large dataset and filtering it 

down, start with more general queries and use drill-through to focus on more specific, 

high-cardinality data. For instance, start by identifying problematic regions or countries 

and then drill down to subnets within those areas for more details.

Here are some limitations:

•	 Calculated columns: Generally this is not supported in 

DirectQuery mode.

•	 Aggregations: These are built in, so manually adding or modifying 

aggregations usually leads to errors.

•	 Custom visuals: Compatibility is not guaranteed with all custom 

visuals, especially those requiring calculated columns.

•	 Cached data reference: This is not supported in DirectQuery mode.

•	 Relative data filtering: This is supported only with the Start Time 

and End Time dimensions.
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•	 Measurement-only queries: This is not supported. Always include at 

least one dimension in your visualizations.

•	 Government cloud support: This is limited to Power BI Desktop and 

requires an appropriate Power BI U.S. government license.

Most limitations are inherent to either DirectQuery connector capabilities in Power 

BI or the design fundamentals of the CQD data model.

By understanding both the capabilities and limitations of the Microsoft Call Quality 

connector and Power BI’s drill-through functionality, you can create more targeted and 

insightful reports.

�Utilizing the CQD PSTN Direct Routing Report 
in Microsoft Teams
The CQD PSTN Direct Routing Report for Microsoft Teams is part of our downloadable 

Power BI query templates. This comprehensive report enables you to closely monitor 

the usage and performance metrics of your Public Switched Telephone Network (PSTN) 

services. With this tool, you can gauge service reliability, Session Border Controller (SBC) 

status, network metrics, and the Network Effectiveness Ratio metric among other 

parameters. This report is pivotal for troubleshooting issues such as call drops, 

understanding volume changes, and assessing the overall call impact.

The report is divided into four main sections.

•	 PSTN Overview

•	 Service Details

•	 Network Effectiveness Ratio

•	 Network Parameters

These are the key features:

•	 Flexible analysis: You can dissect data by various metrics such as 

call type, SBC, and geographic region of both the caller and callee. 

The report offers data aggregation for the previous 7, 30, or 180 days.

•	 Trend monitoring: Evaluate both short-term and long-term service 

reliability with hourly and daily trends. This dual approach lets you 

spot real-time incidents as well as long-term health trends.
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•	 Drill-through capabilities: The report allows for a deeper dive into 

metrics such as Service Detail and Network Effectiveness Ratio. 

Simply click the data point you’re interested in for more specific 

information.

For example, let’s say you want to examine all inbound calls passing through a 

specific SBC with the United States as the internal region.

•	 Call type filtering: Use the top-level filters to select ByotIn as the call 

type, the specific SBC, and US for the internal region.

•	 Usage trends: 180-day trend information is available.

•	 Network metrics: Data on Post Dial Delay, Latency, Jitter, and Packet 

Loss for the past 180 days is shown.

•	 Service capacity: You’ll see charts displaying the maximum volume 

of concurrent calls and daily active users over the past 180 days.

•	 Quality metrics: You can examine the primary reasons affecting call 

quality during this period.

Here are the service details:

•	 Total attempted calls: This is the sum of all calls attempted, both 

successful and failed, in the selected period.

•	 Total connected calls: This is the sum of all successfully 

connected calls.

•	 Total minutes: This is the cumulative minute usage.

•	 Daily active users: This is the number of unique users who made at 

least one successful call on a given day.

•	 Concurrent calls: This is the peak number of simultaneous calls in 

a minute.

•	 User feedback: Rate My Call scores are included, where a rating of 3 

to 5 is deemed good, and 1 to 2 is poor.

By understanding and utilizing these metrics, the CQD PSTN Direct Routing 

Report provides you with the insights needed to optimize your telephony services in 

Microsoft Teams.
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�Teams Call Analytics
Let’s talk about Call Analytics.

�Configuring Call Analytics for Microsoft Teams
As an administrator of Microsoft Teams, you have the capability to employ per-user call 

analytics for identifying and resolving issues related to call quality and connectivity for 

individual users. This is a step-by-step guide on how to fully leverage the Call Analytics 

feature.

Assign targeted roles like help-desk agents to certain individuals to permit them to 

access user-specific call analytics. Note that these roles are restricted from accessing the 

broader Teams admin center.

These are the permissions levels:

•	 Tier 1 support: Assign the Teams communications support specialist 

role to provide limited access to call analytics.

•	 Tier 2 support: Assign the Teams communications support engineer 

role for comprehensive access to call analytics.

You can use the Azure AD for assigning roles.

Here’s how to update the location information:

	 1.	 Uploading a data file: Populate per-user call analytics with 

building, site, and tenant information by uploading a .tsv or .csv 

data file.

	 2.	 Mapping the IP address to the location: Once uploaded, this 

data can be utilized to correlate IP addresses to physical locations, 

assisting admins and support staff in identifying trends or 

common issues among users in a specific location.

	 3.	 Existing data use: If you’re already using Teams or Skype for 

Business, you can repurpose existing tenant and building data 

files from the CQD.
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	 4.	 Download: Navigate to the Microsoft Teams admin center, go to 

Analytics & reports ➤ Call Quality Dashboard ➤ Upload now. 

Click Download next to the desired file in the “My uploads” list.

	 5.	 Upload: For uploading this new file into call analytics, consult the 

guidelines in Add and Update Reporting Labels.

Once the setup is complete, you can commence using per-user call analytics. For a 

deep dive into troubleshooting, refer to the guide “How to Use Per-User Call Analytics to 

Troubleshoot Poor Call Quality.”

By following these steps, you prepare your Microsoft Teams environment for effective 

troubleshooting and analytics, making it easier for support roles to identify and resolve 

issues that users may encounter.

�How to Use Call Analytics to Troubleshoot Poor Microsoft 
Teams Call Quality
Welcome to the deep dive into the world of Call Analytics for Microsoft Teams. As 

anyone who’s worked remotely can tell you, the quality of your calls and meetings can 

make or break your day. If you’re a Teams administrator or someone designated as a 

Teams communications support specialist or engineer, you have tools at your disposal 

to solve these issues. This blog post is designed to walk you through how to use Call 

Analytics to improve the individual call or meeting experience for Microsoft Teams users.

Note T his guide assumes you’ve already set up Call Analytics in Microsoft Teams. 
If you haven’t done so, check out our guide on setting up Call Analytics for Teams.

Call Analytics is a feature within Microsoft Teams that offers granular information 

about each user’s calls and meetings. It’s not just about basic data—this feature provides 

comprehensive analytics on devices, networks, connectivity, and even building or site 

information if you’ve uploaded that data. Whether it’s poor audio quality or connectivity 

issues, Call Analytics can help you get to the root of the problem.

To access this treasure trove of information, navigate to the Teams admin center. 

On the Users tab, select a user profile and then go to the Meetings & Calls tab. This will 

display all calls and meetings for that user within the past 30 days. For more granular 

data, you can click any given session to see detailed media and networking statistics.
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Teams Communications Support Specialist (Tier 1)

•	 Handles basic call-quality issues

•	 Collects relevant data and escalates to the support engineer for 

further investigation

Teams Communications Support Engineer (Tier 2)
Accesses detailed call logs and performs in-depth analysis to solve complex issues.

Activity Information What Tier 1 
Sees

What Tier 2 
Sees

Calls Caller Name, Recipient Name, Caller Phone Number, 

Recipient Phone Number

Limited Data Detailed Data

Meetings Participant Names, Participant Count, Session Details Limited Data Detailed Data

Note  For security reasons, certain sensitive information such as full phone 
numbers will be obfuscated.

�Troubleshooting Steps
Here are the troubleshooting steps:

	 1.	 Locate the user in question: Log in to the Teams admin center 

and use the user search to find the user whose calls you want to 

investigate.

	 2.	 Dive into specific calls or meetings: Under Meetings & Calls, 

you’ll find a list of sessions the user has been part of. Click any to 

get more details.

	 3.	 Inspect the Advanced tab: Look for indicators in yellow and red. 

Yellow signifies a minor issue, and red points to a major problem, 

often the main reason for the poor call quality.
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Refer to Figure 8-2 for user call analytics information.

Figure 8-2.  Teams Call Analytics

Anything in yellow means monitor it, but it’s not critical

Anything in red re quires immediate action.

	 4.	 Understand quality of experience (QoE) data: In some cases, 

quality of experience data might not be available, usually due to 

dropped calls or terminated client connections. For those with 

QoE data, pay attention to the following:

•	 Call setup errors: If error codes like Ms-diag 20-29 appear, the 

call setup failed.

•	 Network issues: Watch for packet loss, jitter, and other network 

problems.

•	 Device malfunctions: Check whether a device is functioning 

properly.
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Call Analytics is a robust tool for troubleshooting and enhancing the Teams calling 

and meeting experience. While the data is immensely detailed and valuable, always 

remember to consult Microsoft Support for complex issues, especially before making 

judgments based on advanced telemetry and diagnostic data.

�Call Quality Dashboard
The Teams Call Quality Dashboard serves as an organization-wide monitoring tool for 

evaluating the quality of calls and meetings on Microsoft Teams, as well as Skype for 

Business Online and Skype for Business Server 2019. Accessible via https://cqd.teams.

microsoft.com, the CQD offers a near-real-time data stream, updating call records 

usually within 30 minutes after a call concludes.

The CQD adheres to Microsoft 365’s standards for managing end-user identifiable 

information (EUII), ensuring data security and compliance. The dashboard aims to 

assist Teams and Skype for Business administrators, along with network engineers, 

in keeping tabs on performance metrics. CQD allows for a synergistic approach with 

individual user call analytics, helping to pinpoint whether poor call quality is an isolated 

or systemic issue.

The dashboard is also instrumental in offering insights into several quality metrics 

including overall call quality, server-client interactions, and voice quality service-level 

agreements (SLAs). It further provides the capability to upload building or endpoint 

data. Doing so enables location-enhanced reports, which can refine the analysis of call 

quality and reliability down to a user’s specific building or network endpoint. To activate 

these specialized views, administrators need to upload the necessary data via the CQD 

Tenant Data Upload page.

To initialize the CQD in Microsoft Teams, visit https://cqd.teams.microsoft.com 

and log in using your administrative credentials. Alternatively, navigate to the Teams 

admin center and choose “Analytics & reports,” followed by the Call Quality Dashboard 

option. Figure 8-3 shows the CQD Summary reports.

Chapter 8  Teams Reporting and Monitoring

https://cqd.teams.microsoft.com
https://cqd.teams.microsoft.com
https://cqd.teams.microsoft.com


736

Figure 8-3.  CQD Summary Report

Once you land on the dashboard page, log in using your either Global Administrator 

or Microsoft Teams Administrator account. The CQD provides a holistic view of call and 

meeting quality, encompassing Microsoft Teams as well as Skype for Business Online 

and Skype for Business Server 2019.

Note that if you’re using Skype for Business Server 2019, you will need to set up the 

Call Data Connector beforehand.

Designate roles to individuals requiring access to the CQD, keeping in mind that 

roles differ in their access levels to various functionalities such as viewing reports, 

accessing end-user identifiable information (EUII), or uploading building data. Roles 

that can access the CQD range from Global Administrators and Teams Administrators to 

more specialized roles like Teams Communications Support Engineer.
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Important Note I f EUII isn’t visible and you possess a role with the appropriate 
access level, be aware that CQD retains EUII for only 28 days, deleting 
anything older.

For a comprehensive understanding of these roles and their capabilities, refer to the 

Office 365 admin roles documentation. Once you’ve logged into the CQD for the first 

time, it will commence the data collection and processing activities.

Microsoft advises uploading tenant and building data for an optimal experience with 

the CQD. Tenant data comes in two forms: building and endpoint files.

�Getting Started
You can download a sample template from https://github.com/MicrosoftDocs/

OfficeDocs-SkypeForBusiness/blob/live/Teams/downloads/locations-template.

zip?raw=true. For building mapping help, read the “Create a building map for CQD” 

guide (https://learn.microsoft.com/en-us/microsoftteams/cqd-building-

mapping).

�Uploading Data
Here’s how to upload data:

	 1.	 Navigate to the CQD from the Teams admin center.

	 2.	 Click the gear icon in the top-right corner.

	 3.	 Choose Tenant Data Upload from the Summary Reports page. 

Figure 8-4 shows a tenant data upload.

Chapter 8  Teams Reporting and Monitoring

https://github.com/MicrosoftDocs/OfficeDocs-SkypeForBusiness/blob/live/Teams/downloads/locations-template.zip?raw=true
https://github.com/MicrosoftDocs/OfficeDocs-SkypeForBusiness/blob/live/Teams/downloads/locations-template.zip?raw=true
https://github.com/MicrosoftDocs/OfficeDocs-SkypeForBusiness/blob/live/Teams/downloads/locations-template.zip?raw=true
https://learn.microsoft.com/en-us/microsoftteams/cqd-building-mapping
https://learn.microsoft.com/en-us/microsoftteams/cqd-building-mapping


738

Figure 8-4.  Uploading tenant data

	 4.	 If this is your first CQD visit, you’ll receive a prompt to upload 

building data.

	 5.	 On the Tenant Data Upload page, click Browse to select a data file.

	 6.	 Set the start date and optionally an end date.

	 7.	 Click Upload.

Before uploading, the system validates your file. If the file fails validation, an error 

message will appear for troubleshooting. For instance, an error could occur due to an 

incorrect number of columns.

Upon successful upload, the uploaded files are listed in the “My uploads” table. It 

might take up to four hours for the file to be fully processed.

If you’ve uploaded a building file already and need to make changes, download the 

original file, amend it, delete the existing file in CQD, and then re-upload.

�File Requirements
Here are the file requirements.

Building Data File

•	 Format: .tsv or .csv

•	 No table header

•	 15 columns in specified order and format (see detailed guide)

•	 Examples and specifics can be found in the detailed guide.
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Endpoint Data File

•	 Format: .tsv or .csv

•	 No table header

•	 7 columns, only String data type allowed, 64 character limit

•	 Further examples and specifics can be found in the detailed guide.

The following are some special considerations:

•	 Supernetting is supported but not recommended.

•	 The VPN column is optional.

•	 Only one active building file can exist in CQD at a time.

For missing subnets, follow these steps:

	 1.	 Go to the Missing Subnet Report on the Quality of Experience 

Reports page.

	 2.	 Download the original building file.

	 3.	 Append new subnets.

	 4.	 Re-upload with a start date set to at least eight months prior.

Note  For a comprehensive view of the report, add your tenant ID as a query filter 
for Second Tenant ID.

This condensed guide is meant to provide an overview. For further details and 

advanced configurations, consult the comprehensive guide.

�Teams CQD Data and Report
The CQD updates call records within 30 minutes after a call ends. However, this near- 

real-time data is retained for only a limited period.
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Choose from various methods to access CQD data:

•	 Teams admin center: This offers basic, noncustomizable call quality 

data on the Users page.

•	 CQD portal: This features customizable, detailed reports and filters.

•	 Power BI: You can view and download customizable templates for 

data analysis.

•	 Graph API: This is an advanced method for in-depth data analysis 

and integration.

Quick-start with two CQD templates: All Networks and Managed Networks. Follow 

the menu steps to import them.

End-user identifiable information (EUII) is stored for 28 days, after which it becomes 

anonymized.

You need the following admin role permissions:

•	 Roles with EUII access: Global Admin, Teams Service Admin, etc.

•	 Roles without EUII access: Reports Reader, Teams Communications 

Support Specialist

The CQD supports rolling-trend reports for various time spans. Use date parameters 

in URLs for specifying the last day in the trend.

These are the types of reports:

•	 Summary reports: These provide a snapshot of call quality.

•	 Detailed reports: These provide in-depth analysis.

•	 Location-enhanced: These require tenant data upload.

•	 Reliability reports: These include all media types.

•	 Quality drill-downs: These break down data by multiple 

dimensions.

•	 Help-desk reports: These include user-specific call and 

meeting data.

•	 Client version reports: These track usage by app versions.

•	 Endpoint reports: These measure call quality by device.
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If default reports aren’t sufficient, create custom ones or use Power BI templates.

Ensure there are no overlaps in subnet information when uploading building files, as 

this may cause incorrect mappings.

�Call Quality Troubleshooting Using the CQD
To ensure optimal performance in Microsoft Teams, it’s essential for IT administrators 

and support engineers to have a proactive strategy for monitoring and sustaining call 

and meeting quality. The CQD is your go-to tool for this purpose, with a particular 

focus on enhancing audio quality as a pathway to improving video and content sharing 

experiences as well.

�Monitoring Categories and Best Practices
After deploying Microsoft Teams for meetings and voice services, it’s crucial to maintain 

regular checks on various aspects of call and meeting quality. Here’s a breakdown:

Call Quality

•	 Segment metrics based on internal (e.g., VPN, Wi-Fi, wired) and 

external calls.

•	 Further classify metrics by building or network.

•	 Monitor calls made through VPN, TCP, UDP, or proxy.

Call Reliability

•	 Address any network or firewall issues.

•	 Evaluate the rates of call setup and drop failures.

•	 Determine where most of these failures occur.

User Experience

•	 Leverage Rate My Call data to gauge the user’s real-world 

experiences.

•	 Pinpoint the source of poor experiences.

•	 Link poor experiences with metrics on call quality, reliability, and 

devices.
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Devices

•	 Analyze which audio and video devices are most frequently used and 

their effects on call quality.

•	 Ensure that drivers for audio, video, USB, and Wi-Fi are up-to-date.

Clients

•	 Study the types and versions of client software in use and their 

impact on call and meeting quality.

�Common Issues and Remediations
Several factors can degrade user experiences.

•	 Firewall or proxy misconfigurations

•	 Weak Wi-Fi signals

•	 Limited bandwidth

•	 VPN issues

•	 Outdated client versions and drivers

•	 Unsuitable audio devices

•	 Faulty subnets or network devices

Prioritize resolving these issues to sustain high-quality experiences across Teams.

�Leveraging CQD Templates for Efficient Assessment
Two predesigned CQD templates are available: one for monitoring all networks and 

another specific to internal networks. Although the All Networks template can show 

building and network data, you can enhance this by uploading custom building and 

location information. This enables CQD to provide more granular and informative 

reports, differentiating between internal and external subnets.

By systematically addressing the areas outlined in this guide, you’ll be well-equipped 

to ensure a consistently high-quality experience for all Teams users.

Quality in Microsoft Teams revolves around both service metrics and the user’s 

experience.
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Service metrics are client-specific metrics collected during each call. These include 

factors like the following:

•	 Poor stream rates (incoming and outgoing)

•	 Setup failure rate

•	 Drop failure rate

The Poor Stream Rate (PSR) metric focuses on the proportion of low-quality streams 

in your organization, aiming to pinpoint areas for improvement.

In CQD, one important metric is the Audio Poor Percentage. PSR comprises five 

network metrics such as jitter, packet loss, and round-trip time. A stream is tagged as 

poor if it surpasses the set limits for any of these metrics.

�Why Use Streams Over Calls?
Streams offer insights into which part of a call—outgoing or incoming—affected quality. 

Stream direction can pinpoint issues from problematic devices to network limitations. 

By focusing on stream data, you can delve into the root cause of poor call quality.

�Setting Up Targets
Setting quality and reliability targets is crucial for ensuring consistent call quality. Here 

are some suggested targets:

Network Type Quality Targets  
(Audio Poor Stream Rate)

Reliability Targets  
(Setup & Drop Failure Rate)

Overall 3.0% 1.0%, 3.0%

�User Experience Metrics
User experience can be subjective but is equally important. The Rate My Call (RMC) 

feature helps collect user feedback to complement service metrics.
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�Device and Client Preparedness
Keeping both client software and devices updated is crucial for optimal user experience.

These are categories for quality management:

•	 Network: Focus on PSR, TCP usage, and the network environment.

•	 Endpoints: Use up-to-date clients and quality audio devices.

•	 Service management:

•	 Microsoft’s role: Maintain Teams and Skype services.

•	 Your role: Keep your organizational settings, like firewalls, 

updated.

Regularly review and adjust your quality management practices to ensure the best 

call and meeting experiences.

�Ongoing Improvements
Microsoft is continually refining its reporting capabilities, adding new metrics, features, 

and additional reports over time.

If you’re a Global Administrator and want to anonymize identifiable information in 

reports, navigate to the Microsoft 365 admin center. Go to Settings, click Org Settings, 

and go to the Services tab. Select Reports. From there, select “Display concealed user, 

group, and site names in all reports.”

By configuring these settings, you’ll anonymize data both in Microsoft 365 and 

Teams admin center reports.

By leveraging the analytics and reporting features in Microsoft Teams, administrators 

can gain a more nuanced understanding of user engagement and system performance. 

This data is critical for optimizing workflows, ensuring efficient resource allocation, and 

promoting effective communication within the organization.
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�Summary
This chapter served as a comprehensive guide for administrators and team leads seeking 

to understand and optimize the performance and usage of Microsoft Teams within their 

organization. The chapter introduced the pivotal role of reporting and monitoring in 

ensuring seamless communication and collaboration through Teams. It then delved 

into various tools and methodologies, from built-in Teams Usage Reports for gauging 

user engagement to the more advanced custom reporting capabilities offered through 

Power BI. For those concerned with call and meeting quality, the chapter discussed 

both individual-level analytics and broader organizational metrics through Teams Call 

Analytics and the Call Quality Dashboard, respectively. It also offered a robust guide for 

troubleshooting call quality issues, harnessing the analytical power of both CQD and 

Call Analytics.

In conclusion, the chapter emphasized that effective reporting and monitoring are 

not just optional but essential for a successful Microsoft Teams experience, thereby 

setting the stage for deeper explorations into Teams functionalities.
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